SZECHENYI ISTVAN ALKALMAZOTT MECHANIKA
EGYETEM TANSZEK

Végeselem modszer 6. gyakorlat
U gerenda

Feladat: U-gerenda modellezése lemezszerkezetként

Adott

Egy U180-as profilbdl késziilt gerenda az egyik végén befalazott, a masik végére egy 10 mm
vastag, 250x250 mm?-es négyzet alaki lemez van felerésitve, mely a terhelés felvételére és
tovabbitasara szolgal.

Terhelés
A gerendan 3 kiilonb6z0 terhelési esetet definialunk:
1. terhelési eset: Csavaras erdparral (gatolt csavaras a 250x250 mm?-es lap miatt)
A és B pontban F, =5000 N

2. terhelési eset: Hajlitas és csavaras a gerinclemez felezOpontjaban miikodo erdvel
C pontban F, =5000 N

3. terhelési eset: ,,Tiszta” hajlitas a csavarasi kozéppontban hat6 erdvel
D pontban F, =5000 N



Anyagjellemzok
Az acél anyagjellemzoi:

E=21-10° MPa
v=0,3

A tarto geometriai méretei
a=180 mm v, =8 mm R, =11 mm
b=70 mm v, =11 mm R, =5,5mm
a=23° | =1000 mm
¢ =250 mm v, =10 mm

Az U-gerenda keresztmetszetét lathatjuk a kovetkezd 2 abran. Baloldalon a valdsdgos
geometria van, a modellezéshez egy egyszertsitett geometriat hasznalunk.
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Feladat mindegyik terhelési esetnél:
— A kozépfeliilet deformalt alakjanak kirajzolasa, a csomdponti elmozdulas értékek
leolvasasa.

— Redukalt fesziiltségek (o, ) szemléltetése a kiilsé és a belsd feliileteken, valamint a kozép-
feliileten szintvonalas dbrakon.

— A radirdnyt normalfesziiltségek (O'y

) a kozépfeliileten szintvonalas dbrakon.

A héj olyan test, melynek egyik merete a masik két merethez kepest kicsi. A legkisebb meret a
vastagsag. Ertelmezhetd kozépfeliilet, amely gorbiilt feliilet is lehet.

A Kirchhoff-Love-héjelmélet nem veszi figyelembe a nyirasi alakvaltozast. A hipotézis szerint
hajlitasnal a kdzépfeliilet normalisai az alakvaltozas utan is normalisai lesznek az alakvaltozott

kozépfeliiletnek és a normalisokon 1évd pontok tdvolsdga nem valtozik.

Ha a héj kozépfeliilete parhuzamos az Xy sikkal — ez az U-gerenda als6 és felso lapja —, akkor a
geometriai hipotézis szerint y,, =y,, =0 ¢és ¢, =0. Az alakvaltozasi allapot:
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A fesziiltségi hipotézis szerint o, = 0. A fesziiltségi allapot az also és fels6 lapon:

o 0

X z-xy
[£]= r, o, 0
0 0 O
A szamitasok elvégzéséhez a tartonak, mint héjszerkezetnek csak a kozépfeliiletét rajzoljuk
meg. A lemez modellhez sziikségiink lesz a kdzépvonalak geometridjara. A kozépfeliileti

méreteket mutatja a kovetkezd abra.
A Kozépfeliileti méretek:

a’ :a—Z-VEZ:a—vz ~180-11=169 mm

b =b_ " —70_8 _66 mm
2 2
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Inditsuk el az Abaqus CAE programot. Adjuk meg a munkakonyvtarat a File » Set
Work Directory... paranccsal. A megjelen6 ablakban a New work directory ala
irjuk/masoljuk be a munkakonyvtarunk helyét, vagy valasszuk ki a A select... ikonnal.
Ezutan OK-zuk le az ablakot.

Eile Model Viewport View

Mew Model Database
Qpen... Ctrl+0
Metwork QDB Connector
Close ODEB...

Set Work Directory... Note: In file selection dialog boxes, you can
click the work directory icon te jump Pl

Sawve Ctrl+5 to the current work directory.

Save fs... [ Cancel |

Compress MDB...

L]
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== Set Work Directory Lé]

Current work directory:

Ghgames\SIMULLA\termp

MNew work directory:

J\Google Drive\01_education\05_VEM\Abac 3

JNl MODULE | PART | geometria megrajzolasa

A program megnyitasa utan alapértelmezésként a Part Modulban vagyunk. Ez a Modul
szolgal a geometria létrehozasara. Ehhez az alabbi Iépéseket kdvessuk:

1. Az eszkoéztarbdl kattintsunk a Create Part ikonra. Az ennek hatasara megjelend Create

Part ablakban az alabbi beallitasokat végezzik el:

A Name utan irjuk be az alkatrészink nevét.
A Modeling Space alatt valasszuk ki, hogy sikbeli, azaz 3D geometriat szeretnénk

rajzolni.

A Type alatt hagyjuk az alapértelmezett kijeldlést a Deformable el6tt, mivel
alakvaltozasra képes geometriat szeretnénk.

A Base Feature alatt valasszuk a Shell-t. A Type-nal pedig az Extrusion opciot.
Az Approximate size-ot, tehat a modellink méretét itt is beallithatnank, de erre
majd késébb visszatérink a segédracs bedllitdsanal, most hagyjuk az

alapértelmezett 200-on.

A fenti beallitadsok elvégzése utan kattintsunk lent a Continue... gombra.

Module: |~ Part : 5 Create Part pS
? E Name: Part-1
}i:— 2 Modeling Space
| Create ® 30 (O 2D Planar () Axisymmetric
/| Part
. Type Options
9,
L (®) Deformable
'_1‘ ﬂ': (O Discrete rigid
2 * Nene available
it ) Analytical rigid
=]
() Eulerian
e
i)
i ‘ Base Feature
qm‘ &8‘ Shape Type
[xlzi -/L‘ ) solid Planar
x @ Shell
.J_.-.j i _ Revolution
g ho () Wire
g Sweep
3‘ E () Point
& % :
2 Approximate size: | 200
@ & Continue... Cancel




2. Az U gerenda geometriajanak megrajzolasahoz:

Valasszuk el6szor az eszkdztarbol a Create Isolated Point parancsot, majd adjuk
meg két sarokpont koordinatait alul a beviteli mezdben. Tehat irjunk be -33, 84.5 -6t
majd kézépsé gombbal fogadjuk el, ezutan irjunk be 33, -84.5 —6t majd szintén

fogadjuk el k6zépsé gombbal. Ezutan a grafikus ablakon megjelent a két pont.

Ezutan a Create Lines: Rectangle paranccsal rajzoljunk egy téglalapot, aminek egy

atlon 1évo két ellentétes sarokpontja az el6bb megadott két pont.
A Delete paranccsal toroljuk ki a téglalap jobb oldalat, hogy megkapjuk az U profilt.

Végul a beviteli mez6ben kattintsunk a Sketch the section for the shell extrusion
melletti Done gombra és a felugré Edit Base Extrusion ablakban a Depth sorba irjuk

be a kihuzas értékét, vagyis 1000 -et.

Medule: |2 Part

]~

| Pick a point--or enter X Y2 |-33, 24.5

X Pick a point--or enter X,¥: | 33, -84.9

A2.2

Create Lines:
Rectangle

{Tj (4 Lines)

A2.3

A2.4

A2.5




Maodule: | Part

A2.8 A2.9
% Edit Base Extrusion *
End Condition
Type:  Blind
Depth: | 1000
= 2| Sketch the section for the shell extrusion |Done Options

MNote: Twist and draft cannot be specified together.
Dlinclude twist, pitch: |0

[ Include draft, angle: |0

Cancel

A2.10 A2.11

3. Az U gerenda megrajzolasa utan rajzoljuk meg a lemez geometriajat.

A Name utan irjuk be az alkatrészink nevét legyen lemez.

A Modeling Space alatt valasszuk ki, hogy sikbeli, azaz 3D geometriat szeretnénk
rajzolni.

A Type alatt hagyjuk az alapértelmezett kijeldlést a Deformable eltt, mivel
alakvaltozasra képes geometriat szeretnénk.

A Base Feature alatt valasszuk a Shell-t. A Type-nal pedig az Planar opciét.

Az Approximate size-ot, tehat a modellink méretét itt is beallithatnank, de erre
majd késbébb visszatérunk a segédracs beallitasanal, most hagyjuk az
alapértelmezett 250-on.

A fenti beallitdsok elvégzése utan kattintsunk lent a Continue... gombra.

Ezutan a Create Lines: Rectangle paranccsal rajzoljunk egy téglalapot, aminek
a mérete 250x250 mm vagyis a segéd racshaldt keretezi korbe.



Ahhoz, hogy a vazlatbdl alkatrész legyen a lenti beviteli mezében kattintsunk a Sketch the
section for the planar shell melletti Done gombra (vagy nyomjuk meg a ko6zéps6
egergombot) Ennek hatasara elkészil a Part-unk, és visszaall a Part Modul alap
eszkdztara.

— Y
- Create Part *
Module: | Part -
- Name: | lemez
Modeling Space
7
Create ® 30 (O 2D Planar () Axisyrmmetric
| Part
. Type Options
9, a
0 ' (® Deformable
1 [~ (O Discrete rigid
et —'— i g. . Maone available
'l (O Analytical rigid
== .
() Eulerian
[ -
W, dm
‘?@ Base Feature
o %‘ Shape Type
o Osoid |G
‘j"ﬂ + @ Shell Extrusion
—, e . Revolution
) Wire 5
™ WeEp
HE‘ E‘ O Point
@ @ Approximate size: | 250
Continue... Cancel
A3.1 A3.2

Module: | Part

Create Lines:
Rectangle

4 Li
@ {4 Lines)

A3.3 A3.4




ol MODULE | ASSEMBLY |EYZalies

Ennek a |épésnek tobb alkatrészbdl allé szerkezetek esetében van igazan jelentésége, mivel
itt tudjuk létrehozni az Osszeallitast. Kilon-kilon mar létrehoztuk a két alkatrészt most
készitenlnk kell a két alkatrészbdl egy 6sszeallitast. Ehhez kattintsunk az Assembly modul
Create Instance ikonjara, majd a Parts menupontnal jeloljik ki mindkét korabban létrehozott
alkatrészt majd kattintsunk az OK gombra. Ezutan a Merge/Cut Instances paranccsal
egyesitsiik a két alkatrészt. A felugré ablakba adjuk meg egy nevet, majd Continue. Ezutan
jeloljuk ki a két alkatrészt véguil lent a beviteli mezében a Select the instances to merge —nél
kattintsunk a Done gombra.

4= Create Instance =
Create instances from:
Module: |5 Assembly : @) Parts O Models
| 0oo Parts

% o

- il
W Create sne
{ Instance
= ==
I ©

1 Instance Type
:I—LL 'UJT—l (®) Dependent {mesh on part)

i @) Independent (mesh on instance)
=

Note: To change a Dependent instance's
'+€ E_'I mesh, you must edit its part's mesh,
a M. [] Auto-offset from other instances
oK Apply Cancel
C1 C2
% Merge/Cut Instances X

Mote: This function will create a new part and

Module: |: Azzembly automatically instance it into the assembly.

Part name: | lemez_u_gerenda

A maE
%} =0 Operations
- L ®) Merge

® Geometry () Mesh (") Both
(O Cut geometry

Options

=
B e

Original Instances
Merge/Cut (®) Suppress () Delete

.| Instances

ry Geometry
= Intersecting Boundaries
Remove
_— ® semove [
R‘ E_-I‘ () Retain %
C3 C4




B WY[elnlV/R=NM eI =330 tulajdonsagok megadasa

Valasszuk ki fent a Property modult. Itt tudjuk megadni az anyagjellemzdket, illetve rid esetén
a keresztmetszeti jellemzéket. Ehhez az alabbi 3 |épésen kell végmenni:

1. Anyag definialasa: Elsé lépésként egy anyagot kell definialnunk. Ehhez a Property modul
eszkoztarabdl kattintsunk a Create Material ikonra. A megjelend Edit Material ablakban
végezzik el a kdvetkezd beallitasokat:

o Nevezzik el az anyagot: a Name:
e A linearisan rugalmas anyagjellemz6k megadasahoz a Material Behaviors
mezd6ben adjuk ki a Mechanical » Elasticity » Elastic parancsot
o Az ekkor megjelené Elastic mezében az alabbi beallitasokat végezziik el:
oA Type mellett hagyjuk az alapértelmezett Isotropic-ot (az
anyagtulajdonsagok iranyfliggetlenek)
o A lenti Data tablazatban a Young’'s Modulus ala irjuk be a rugalmassagi
tényez6t, azaz 2.1e5 (MPa) —t, a Poisson’s Ratio ala pedig a Poisson
tényez6t, azaz 0.3-at.

- S Edit Material X -~ .
; = Edit Material X
Module: |5 Property -
Name: Material-1 Name: | Material-1
T - Description: Y Description 9
Material Behaviors Material Behaviors
— eestic |
i
o Create
| Material
: [E==l
Genersl [ Mechanical Thermsl  Electrical/Magnetic  Other General  Mechanical Thermal  Electrical/Magnetic  Other v
=
E == Elastic
Plasticity > Hyperelastic
n2 Damage for Ductile Metals »  Hyperfoam Type: | Isotropic > ¥ Subeptions
nl Damage for Traction Separation Laws b Low Density Foam [ Use temperature-dependent data
&l t Damage for Fiber-Reinforced Composites b Hypoelastic E
a 4 3 Number of field veriables: [E
Damage for Elastomers > Porous Elastic
Deformation Plasticity Viscoelastic Moduli time scale (for viscoelasticity: Long-term
I == Damping []No compression
Expansion [ No tension
Brittle Cracking -
ats
® @
- Viscosiy Modvus  Rovo
: sty e
f: =+
o, O,
"
o P oK Cancel
1

2. Section definidlasa: A Property Modul eszkéztarabdl kattintsunk a Create Section ikonra.
Az ekkor megjelen6 Create Section ablakban az alabbi beallitdsokat végezzuk el
haromszor:

o Nevezzik el a section-t a Name sornal elészér V1, majd V2 és V3 néven
e A Category alatt valasszuk ki a Shell —ot
e A Type alatt valasszuk a Homogeneous —t, ezutan kattintsunk a Continue...
gombra.
o A felugré ablakban a Shell thickness Value sorba adjuk az egyes Section-ok
vastagsag értekeit V1-nél 8-at, V2-nél 11-et, V3-nal 10-et.
Ezutan kattintsunk az OK gombra, és ismételjuk meg a lépéseket mig mindhdrom
section-t meg nem adtuk.




7
A
b
&

Mame: | V3

Category  Type

O sold
(@) Shell Composite
O Beam Membrane
Surface
Clons General Shell Stiffness
Continue... Cancel

Section integration: (®) During analysis () Before analysis

Basic  Advanced

Thickness
Shell thickness: @) Value: 10
() Element distribution:
() Nodal distribution:
Material: Material-1 M Ee

Thickness integration rule: @ Simpson () Gauss

Thickness integration points: | 5>

Options: %

OK

45 Edit Section X
= MName: V1
Module: |v Property IE o Create Section e Type:  Shell / Continuum Shell, Homogeneous
T @ Section integration: ®) During analysis (O Before analysis
Vii= Name: | V1 -
Basic  Advanced
i Category — Type Thickness
:EI: Create ®' C it O Element distributi
. H ement distribution:
Section i amposrte i
i )
ey () Beam | Membrane O Nodal distribution: &
z Surface
& Q:;"tl O Other X Material: Material-1 v B
. " General Shell Stiffness . . )
Thickness integration rule: @ Simpsan (O Gauss
m‘ Thickness integration points: | 55
o Options: 2
oK Cancel
% Edit Section X
Mame: V2
Module: || Prope E — i
- Property 5r Create Section x Type:  Shell / Continuum Shell, Homogeneous
G~ = . Section integration: @ During analysis () Before analysis
= MName: | V2 9 g analy ¥
Basic  Advanced
i Category | Type Thickness
:ET: Create C it O El t distributi
Section omposite ement distribution: "
x)
!- = O Beam Membrane ) Nodal distribution: ®
2
E ('g"tl () Other Surface Material: | Material-1 M Ee
‘ “ General Shell Stiffness Thickness integration rule: @ Simpson () Gauss
|$‘ Thickness integration points: | 5=
o — — BlER
oK Cancel
% Edit Section x
Name: V3
Module: |5 Property E 2 Create Section % Type:  Shell / Continuum Shell, Homegeneous

B o

Cancel

B2.7

B2.8

B2.9

3. Section-6k geometriahoz rendelése: Ehhez kattintsunk a Property modul eszkdztarabol

az Assign Section ikonra. Ezutan jeldljik ki az U gerenda gerincét, majd a lenti beviteli
mezdben kattintsunk a Done gombra majd a felugré ablakban valasszuk ki a V1-es
section-t, majd OK. Ezt a 1épést még kétszer kell megismételnunk. Jeldljuk ki az U
gerenda dvlemezeit és rendeljik hozza a V2-es section-t. Végul jeldljuk ki a 250x250-es
lemezt és rendeljuk hozza a V3-as section-t.
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4 Edit Section Assignment b4

Module: |3 Property Region
Region: Set-1
O @
|£ £ Section
Section: | V1 o3

=)
! Assign ‘

Note: List contains only sections
applicable to the selected regions.

Type:  Shell, Homogeneous

Material: Material-1

Section
5 X,

& 2
=]

Thickness

Assignment: @ From section () From geometry

Shell Offset
Definition: | Middlesurface || &

A
oK Cancel

5 Edit Section Assignment b4
Medule: :Property Region

Region: Set-2
T a
/e Secton

Section: | V2 [

2
E Assign ‘

Note: List contains only sections
applicable to the selected regions.

Type:  Shell, Homogeneous

Material: Material-1

Section

==t
=8
@

A

Thickness

Assignment: @ From section () From geometry

Shell Offset
Definition: | Middlesurface v &

0K Cancel

B3.6

B3.4

4 Edit Section Assignment X
Module: |5 Property Region

Region: Set-3
¥, -
e secton

Section: | V3 Ul 3

NE
E As;i.gn ‘
el
&

L=

A

Note: List contains enly sections
applicable to the selected regions.

Type  Shell, Homogeneous

Material: Material-1

Thickness

Assignment: @) From section () From geometry
Shell Offset

Definition: | Middlesurface | &

oK Cancel

B3.7 B3.9

)] MODULE | STEP lépések megadasa

A Step modulban a végrehajtandé vizsgalat(ok) tipusat (pl. statikus, dinamikus, hétani...), azok
részleteit és sorrendjét tudjuk beallitani. Jelenleg 1 db statikus Iépést kell definidlnunk. Ehhez
kattintsunk a Step modul Create Step ikonjara. a megjelené Create Step ablakban nevezzik
el a Iépést: a Name -nél. A Procedure type-nal valasszuk a Linear perturbation-t. Ezutan
kattintsunk a Continue... gombra, majd a megjelend Edit Setup ablakban hagyjunk mindent
alapértelmezésen, csak OK-zuk le.
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= Create Step *
4 Edit Step *®
Mame: | Step-1
Name: Step-1
Module : Step - Insert new step after Type: Static, Linear perturbation
- Description: [
e a Nigeorn: OFf
#| Create
o
| Step
Py
RS
11040
I Proceduretype: | Linear perturbation
t%. R Buckle
rJE Frequency
¢
(Y2 "#\ Steady-state dynamics, Direct
P . Substructure generation
H
J‘:j. iy
oK Cancel
D1 D2 D3
&l MODULE | MESH halo elkészitése

A végeselem halot a Mesh modulban tudjuk elkésziteni. Legel8szor fent az Object-et allitsuk
at Part-ra, aminek hatasara a Part mellett megjelenik a racsos tarto felirat.

Module: |: Mesh E| Model: | Model-1 E| Object: () Assembly C[:}Part * ricsos tarté :
T . |
Ezutan a halézast az alabbi lépésekben végezzik el:

1. Lemez felulet felvagasa:

Els6 1épésként mivel még nem hoztuk létre azokat a pontokat, amikre a terhelések meg
kell adnunk ezért els6ként felvagjuk a lemez fellletét ugy, hogy ezek a pontok
kiadddjanak. Ehhez kattintsunk a Partition Face: Sketch ikonra. Majd jeldljik ki az a
felUletet, amit fel szeretnénk vagni, tehat kattintsunk, a lemezre majd kézépségombbal
fogadjuk el a kijeldlést. Ezutan a lenti beviteli mez6ben valasszuk ki a vertical and on the
left opcidt ezutan pedig kattintsunk az U gerenda gerincének lemezzel érintkezd vonalara.
Ekkor visszakapjuk a sketch modult, amiben rajzoljuk meg a Create Lines: Connected
paranccsal azokat a vonalakat, amik mentén a fellletet felvagjuk (lasd a lenti abran).
Ezutan az Add Dimension paranccsal méretezzik be a berajzolt figgéleges vonalat a
gerinchez képest 25.16 mm-re. Végul kattintsunk a beviteli mez8ben a Done gombra.

12



Module: [ Mesh
flag [,
kb=
x )
=4
5

B
&, Iy
w
'S

Partition Face:
A Sketch

iy A

oA,

TN

4 X seectan edge ot s that willappesr verticalsndontheright ]

ertical h
ssstully rtical and on the ight

horzontal and on the top

Jsers\asdf\Docunentz\Abagus felaqhorizontal andonthebottom s cae®

F1.1

F1.2

F1.3

F1.4
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F1.5

2. Elemtipus megadasa:
o Kattintsunk a Mesh modul Assign Element Type ikonjara.
o Jelbljuk ki a teljes geometriat.
e Alenti beviteli mez6ben kattintsunk a Done gombra
e A megjelené Element Type ablakban a Family-t allitsuk Shell-re, a Geometric
Order-t pedig legyen Quadratic, majd OK-zuk le az ablakot.

4F Element Type b4
Element Library Family
@ Standard () Explicit Heat Transfer ~
Membrane
Geometric Order Surface
O Linear @ Guadraiid v
Module: = Mesh
Quad  Tri
) B Element Controls
e s
5 DOF per node: 05 @6
I ] @ Drilling hourglass scaling factor: @ Use default () Specify
% E( Viscosity: ® Usedefault O Specify
s Element deletion: ® Usedefault (O Yes (O No
Assign Max Degradation: @) Use default (O Specify
Element Type
“H, &=
58R: An &-node doubly curved thick shell, reduced integration.
Note: To select an element shape for meshing,
select "Mesh->Controls” from the main menu bar.
oK Defaults Cancel

3. Elemméret megadasa:
Ehhez az alabbi Iépéseket végezziik el:
e Kattitnsunk a Mesh modul Seed Part ikonjara.
e A megjelen6 Global Seeds ablakban az Approximate global size mezd&ben irjunk
be 8 -at. Ezutdn OK-zuk le az ablakot.

14



_D
% Global Seeds x

Sizing Centrols

Module: |5 Mesh Approximate global size: |8

Curvature control
Maximum deviation factor (0.0 < h/L < 1.0): | 0.1

i____ (Approximate number of elements per circle: 8)
9& @ Minimum size control
% Eé‘ (®) By fraction of global size (0.0 < min < 1,0} |0.1
— @] By absolute value (0.0 < min < global size) |5
oK Apply Defaults Cancel

4. NegyszdOg alaku strukturalt halé megadasa: Kattintsunk az Assign Mesh Controls ikonra
ezutan jeldljuk ki a teljes geometriat majd kattintsunk a k6zépsé gombbal. A felugré Mesh
Controls ablakban az Element Shape-nél allitsuk be a Quad-ot a Technique-nél pedig a
Structured menipontot, majd kattintsunk az OK-ra.

2= Mesh Controls X

Module: |5 Mesh Element Shape

® Quad ) Quad-dominated ) Tri
Fo [b,
i =

Technigue Algorithm Options
Minimize the mesh transition 3"

IEEE () Free |:|
=
@ (O Sweep |:|
Pﬂ Redefine Region Corners...
oK Defaults Cancel
F4.1 F4.2 F4.3

5. Végeselem hald elkészitése:
A végeselem halo elkészitéséhez kattintsunk a Mesh modul eszkéztaraban a Mesh Part
ikonra, majd a lenti beviteli mezében az OK to mesh the part? mellett a Yes gombra.

Module: |5 Mesh : Model:[

(5
%Eﬁ OK to mesh the part?
HMesh Parﬂ
T
F5.1 F5.2

15



F5.3

6. Haldtulajdonsagok lekérdezése (opcionalis)

A csomopontok és végeselemek szamanak ellenérzéséhez a Tools » Query...
Parancsot hasznalhatjuk. A felugr6 Query ablakban a General Queries mez&ben
kattintsunk a Mesh-re, majd a lenti beviteli mezét a Query entire part-on hagyva a Done
gombra. Ekkor a lenti parbeszédablakban megjelenik a csomépont szam (Total number
of nodes) és az elemszam (Total number of elements).

=l MODULE | LOAD peremfeltételek megadasa

A Load modulban tudjuk megadni a kinematikai peremfeltételeket (megfogasokat) és
dinamikai peremfeltételeket (terheléseket). Jelen feladatban 1 megfogast és 4 terhelést kell

definialni.

1. megfogasok definialasa: (az alabbi Iépéseket kétszer kell végcsinalni)

Kattintsunk a Load modul Create Boundary Condition ikonjara.

A megjelené Create Boundary Condition ablakban nevezziik el a megfogast, a
Category-t hagyjuk az alapértelmezett Mechanical-on, a Types for Selected Step
alatt pedig valasszuk ki a Symmetry/Antisymmetry/Encastre-t. Ezutan
kattintsunk a Continue... gombra.

Jeldljuk ki a rajzon a megfogas megfelels helyét (kijeldléskor egy piros vonal jelenik
meg a kijel6lés helyén).

A lenti beviteli mez6ben kattintsunk a Done-re

Az ekkor megjelend Edit Boundary Condition ablakban a fix megfogas esetén
valasszuk az ENCASTRE (U1=U2=U3=UR1=UR2=UR3=0). OK-zuk le az ablakot.

befalazas |
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Medule: | Load :
L
L ER

Create
Boundary

[ Condition
T sl |

El.1

# Create Boundary Condition X
Mame: BC-1

Step: | Step-1 M

Procedure: Static, Linear perturbation

Category Types for Selected Step

® Mechanical Symmetry/Antisymmetry/Encastre
(O Electrical/Magnetic | Displacement/Rotation
O Other Connector displacement

Continue... Cancel

E1.3

I
Select regions for the boundary condition ( [¥] Create set: ) %

El.4

5 Edit Boundary Condition x

Mame: BC-1
Type:  Symmetry/Antisymmetry/Encastre
Step:  Step-1 (Static, Linear perturbation)
Region: Set-1

CSYS: (Global) [ L

(O XSYMM (U1 = UR2 = UR3 = 0)

(O YSYMM (U2 = UR1 = UR3=0)

() ZSYMM (U3 = UR1 = UR2 = 0)

(DI XASYMM (UZ=U3=UR1 =0 Abaqus/Standard only)
(O YASYMM (U1 = U3 = UR2 = 0; Abaqus/Standard only)
(O ZASYMM (U1 = U2 = UR3 = 0; Abaqus/Standard only)
(O PINMED (U1=U2=U3=0)

(®EMNCASTRE (U1=U2=U3=UR1=UR2 = UR3 =0}

oK Cancel

E1.5
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2.

terhelések definialasa: (a lenti Iépéseket négyszer kell megcsinalni)
o Kattintsunk a Load modul Create Load ikonjara.

o A megjelen6 Create Load ablakban nevezzik el megoszlo terhelésnek, az erét
pedig koncentralt erének. . A Category-t hagyjuk az alapértelmezett Mechanical-
on, a Types for Selected Step alatt pedig valasszuk ki a Concentrated Force-ot

koncentralt er6 megadasnal. Ezutan kattintsunk a Continue... gombra.

o Jeldljuk ki a rajzon a koncentralt er6 helyét. (kijeldléskor egy kis piros pont jelenik

meg a kijel6lés helyén).

¢ A lenti beviteli mez6ben kattintsunk a Done-re

o Az ekkor megjelend Edit Load ablakban adjuk meg az er6komponensek nagysagat

N-ban: (CF1=5000, majd CF1=-5000, ezutan CF2=-5000 vegul CF2=-5000)

F1 erépar fent

Madule: | Load :
e

F1 erépar lent

Medule: |5 Load :
4

[L: Create Create
Leoad Load
e = B2
I s
E2.1 E2.6
= Create Load x :} Create Load b
MName: F1_fent Name: | F1_len]
Step: | Step-1 v

Step:  Step-1 M

Procedure: Static, Linear perturbation

Category Types for Selected Step
Moment
O Acoustic Pressure

Shell edge load

Surface traction
(O Electrical/Magnetic Body force
Line load
Gravity

Pipe pressure

() Other

Generalized plane strain
Rotational body force
Coriclis force
Connector force
Connector morment
Inertia relief

Continue... Cancel

Procedure: Static, Linear perturbation

Category Types for Selected Step
Moment
() Acoustic Pressure

Shell edge load

Surface traction
() Electrical/Magnetic Body force
Line load
Gravity

Pipe pressure

() Other

Generalized plane strain
Rotational body force
Coriolis force
Connector force
Connector moment
Inertia relief

Cancel

E2.2

E2.7
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E2.3 E2.8
=/ | X | Select points for the load [ [V] Create set: ) |Dq Slele:t points for the load ( [¥] Create set: ) (D]
e I

E2.4 E2.9
& Edit Load X 5 Edit Load b

Mame: F1_fent

Type:  Concentrated force

Region: Set-2

Step:  Step-1(Static, Linear perturbation)

CS¥S: (Global) [ L

Distribution: | Uniform ™
CF1: 5004

CF2:

CF3:

[ Follow nodal rotation

Note: Force will be applied per node.

fix)

QK Cancel

E2.5

Mame:  Fl_lent

Type:  Concentrated force

Step: Step-1 (Static, Linear perturbation)
Region: Set-3

CSYS: (Global) [ L

Distribution: | Unifarm | fix)
CF1: -5000

CF2:

CF3:

] Follow nodal rotatien

Note: Force will be applied per node,

oK Cancel

E2.10

F2 ero

F3 ero

Module: | Load :

|

L A=)

Module: |5 Load :
4

D; Create

Load

= =2
I B2

E2.11

E2.16




= Create Load X
Mame: |F2
Step: |Step-1 4

Procedure: Static, Linear perturbation

Category Types for Selected Step

® Mechanical Concentrated force ~
Therma Mement

O Acoustic Preszure

Shell edge load

Surface traction

() Electrical/Magnetic Body force

Line load
Gravity

Pipe pressure

() Other

Generalized plane strain
Rotational body force
Coriclis force
Connector force
Connector mement
Inertia relief

Continue... Cancel

%5 Create Load *
Mame: | F3
Step: | Step-1 e

Procedure: Static, Linear perturbation

Category Types for Selected Step
(® Mechanical Concentrated force 2

Morment

Pressure

Shell edge load
Surface traction
Body force

Line load
Gravity

Pipe pressure

Generalized plane strain
Rotational body force
Coriolis force
Connector force
Connector moment
Inertia relief

Continue.., Cancel

E2.12

E2.17

E2.13

E2.18

Select points for the load ( Create set:

e

Select points for the load ( [V] Create set:

E2.14

E2.19

5 Edit Load X
MName:  F2

Type:  Concentrated force

Step:  Step-1 (Static, Linear perturbation)
Region: Set-4

C5YS: (Global) [p L

Distribution: | Uniform | fix)
CF1:

CF2: -5000

CF3: I

[ Follow nodal rotation

Note: Force will be applied per node.

QK Cancel

= EditLoad ¥
Mame: F3

Type:  Concentrated force

Step:  Step-1 (Static, Linear perturbation)
Region: Set-5

CSYS: (Global) [3 L

Distribution: | Uniform | i)
CF1:

CF2: -5000

CF3:

[ Follow nodal rotation

MNote: Force will be applied per node.

oK Cancel

E2.15

E2.20
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3. Terhelési esetek megadasa:

o Kattintsunk a Load modul Create Load Case ikonjara.

e A megjelend Create Load Case ablakban nevezzik el terhelési eseteket. Ezutan
kattintsunk a Continue... gombra.

o Az Edit Load Case ablakban a Load fuldon kattintsunk a zéld + ikonra (Add). Jeldljuk
ki a listabdl a terhelési esetnek megfeleld terhelést. Ezutan OK gombra kattintsunk.

o Az Edit Load Case ablakban Iépjlink at a Boundary Conditions fulore kattintsunk a
zold + ikonra (Add). Jeldljuk ki a listabol a terhelési esetnek megfeleld
megfogasokat. Ezutan OK gombra kattintsunk.

o Majd kattintsunk a OK-ra

1. terhelési eset - F1 er6par | 2. terhelési eset - F2 er§ 3. terhelési eset — F3 erd
Module: |5 Load v Module: | Load v Module: |5 Load e

ks £2
b B2
= B2
o B2

ks 2
L Y=
= 2
I B2

s £
L R =
= B
b =

Create Create Create
| Load Case Il Load Case | Load Case
' o o
e, e
5 Create Load Case b 5r Create Load Case x S+ Create Load Case >
Mame: F'I_eropaI Mame: FZ_eri Name: F3_erq
Step: | Step-1 I Step: | Step-1 I Step: | Step-1 ~
Procedure: Static, Linear perturbation Procedure: Static, Linear perturbation Procedure: Static, Linear perturbation
| —— | I ———
e -
Edit Load C *
5 Edit Load Case 2 Edit Load Case x 48 Edit Load Case X
Mame: megoszld terhelés R . . N
MName: koncentralt erd Name: megoszlé + koncentrélt
Stepe terheliel eatek Sttt e et by Step:  terhelési esetek (Static, Linear perturbation) Step:  terhelési esetek (Static, Linear perturbation)
Loads  Boundary Conditions Loads  Boundary Conditions Loads  Boundary Conditions
Click mouse button 3 for table options. Click mouse button 3 for table options. Click mouse button 3 for table options.
Name Scale Factor Name Scale Factor Name Scale Factor
1 1 1 1 1 1

FIgrght selections in viewport Highlight selections in viewport

grirght selections in viewport

oK C |
oK Cancel OK Cancel ancel

E3.3 E3.9 E3.15
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2= Load Selection X
Load Type

F1_fent Concentrated force
Fl_lent Concentrated force

F2 Concentrated force

F3 Concentrated force

Scale factor: |1

Highlight selections in viewport

2= Load Selection x
Load Type

F1_fent Concentrated force
F1_lent Concentrated force

F2 Concentrated force

F3 Concentrated force

Scale factor: | 1
Highlight selections in viewport

# Load Selection

Load
F1_fent
F1_lent
F2

F3 Concentrated force

Scale factor: |1

Highlight selections in viewport

Type
Concentrated force
Concentrated force

Cencentrated force

QK Dismiss

oK Dismiss

E3.4

E3.10

OK

E3.16

Dismiss

% Edit Load Case X

Name: megoszld terhelés

Stepr  terhelési esetek (Static, Linear perturbation)

Loads

In addition to selections below, use all boundary
cenditions propagated or modified from the base state,

Click mouse button 3 for table options.

4% Edit Load Case *

Mame: koncentralt erd

Step:  terhelési esetek (Static, Linear perturbation)

Loads

In addition to selections below, use all boundary
conditions propagated or modified from the base state,

Click mouse button 3 for table options.

¢ Edit Load Case

Click mouse b

Name: megoszlé + koncentralt
Step:  terhelési esetek (Static, Linear perturbation)
Loads | Boundary Conditions ¢

In addition te selections below, use all boundary
conditiens propagated or modified from the base state.

utten 3 for table options,

BC-1 Symmetry/Antisymmetry/E|

Scale factor: |1

Highlight selections in viewport

BC-1 Symmetry/ Antisymmetry/E|

Scale factor |1

Highlight selections in viewport

Name Scale Factor Name Scale Factor Name Scale Factor
1 1 1 1 1 1
+ ¥ + &
7
grMght selections in viewport Highlight selections in viewport
t selections in viewport
OK Cancel 0K Cancel
OK Cancel

—] Boundary Condition Selection x —] Boundary Condition Selection x —] Boundary Condition Selection *
Boundary Condition Type Boundary Condition Type Boundary Condition Type

BC-1 Symmetry/ Antisymmetry/E|

Scale factor: | 1

Highlight selections in viewport

QK Dismiss

E3.6

OK Dismiss

E3.12

oK

E3.18

Dismiss

el MODULE | JOB | feladat megoldasa

A feladatot a Job modulba atlépve tudjuk lefuttatni. Az ehhez sziikséges Iépések:

1. Feladat definialasa:

e A Job modul eszkdztarabdl kattintsunk a Create Job ikonra
¢ A megjelend Create Job ablakban kattintsunk a Continue... gombra
e A megjelend Edit Job ablakban hagyjunk mindent alapértelmezésen és OK-zuk le
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2 Edit Job =]

Neme: Job-1
( I Model: Model-1
= Create Job Iﬂ
Analysis product: Abaqus/Standard
Name: | Job-1 Description:
Submission | General | Memory | Parallelization | Precision
Source: | Medel EI
Job Type
() Restart
Run Mode

© Background ) Queue

Submit Time

@ Immediately

[ Contiw [ Cancel S e
C
Gl.1 G1l.2 G1.3

2. Feladat lefuttatésa:
e A Job modul eszkdztarabdl kattintsunk a Job Manager ikonra
¢ A megjelené Job manager ablakban alapbdl ki van valasztva az elébb definialt 1
db feladat (Job-1). Kattintsunk a Submit gombra.
¢ Ha a Status alatt megjelenik a Completed felirat, akkor a feladat sikeresen lefutott.
Az eredmények megjelenitéséhez kattintsunk a Results gombra.

Module: |5 Job '3 Job Vanager (& Job Manager .
[z - = e
Name Model Type Status Name Model Type Status
"
Ba b
Manager
k&=
ith e ] (] e () (s
& - 7

H EYChNINNRVIVARVINOINN credmények megjelenitése

A Results gombra kattintva automatikusan a Visualisation modulba kerilink. Fent valasszuk
ki az U-t vagy az S-t annak megfeleléen, hogy az elmozdulast, vagy a feszliltséget szeretnénk
megjeleniteni. EI6szo6r valasszuk az U-t.

s o o s

rauts [+] 5+ : B pimary [+ s i F[E]

E
RF
5

-
A Plot Contours on Deformed Shape ikonra kattintva a deformalt alakot lathatjuk.

dl
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ODB: Job-1.0db  Abaqus/Standard 3DEXPERIENCE R2017x  Thu Nowv 02 14:35:19 GMT+01:00 2017

Step: Step-1 o
Load Case: F1_EROPAR
U, Magnitude

Bal felll Iathaté szinskala alapjan a maximalis elmozdulas 0,2912 mm.

A Contour Options-ban a Limits fulon bekapcsolhatjuk a max/min helyek megjelenitését.
MIDOUIE: || VISUaNzaton ‘¢ Contour Plot Options -t 2. Sue

| | Basic | Color &Style | Limits | Dther

Q- 123 E% | Note: User-defined interval values override

L2124 the settings below.
= Uy Manl e
plfe] === |
B H ' Max @ Auto-compute 0.0190805) [¥] Show location
+"

H M @ Auto-compute () 4| Show location

g B b Specity: 00190808 '
“r... + Specify: 0 ‘
% +
sl

+ Auto-Computed Limits
C ontou r Gptl ons I When auto-computing animation himits:
Use imats from all frames -
| + ‘
Qase
lﬂl}, H +
@ !"E +
fa == +
[ (CApply | | Deteuns | | Cancel
et et

Az elmozdulasok kiértékelése utdn nézzik meg a redukalt feszlltség eloszlast.

Eﬁ: Primary E| u H Magnitude E|
CF

E
RF
S

]
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ODB: Job-1.0db Abaqus/Standard 3DEXPERIENCE R2017x Thu Now 02 14:35:19 GMT+01:00 2017

Step: Step-1 o
Load Case: F2_ERD
B ;

QDB: Job-1.0db Abaqus/Standard 3DEXPERIENCE R2017x  Thu Nowv 02 14:35:19 GMT+01:00 2017
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